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Chapter 1:  

Introduction 

 
 

POPRECON 2 (POPulation RECONstruction), 

http://www.cbr.washington.edu/analysis/apps/PopRecon 

 

Program POPRECON 2 was developed to estimate population abundance 

based on full age-at-harvest data, supplemented with harvest effort and 

auxiliary estimates of survival, abundance, or harvest vulnerability.  

Maximum likelihood methods are used to estimate annual harvest 

probabilities which are, in turn, used to estimate age class and annual 

abundance, based on Horvitz-Thompson type estimators as described in 

Gast et al. (2013).  Random effects can be added to the survival and/or 

harvest processes to account for annual stochasticity in the parameters. 

Data processing is based on AD Model Builder (Fournier et al. 2011), 

which uses both symbolic differentiation and numerical integration. 

Program POPRECON has combined ADMB with a user-friendly interface for 

ease and convenience of use.  Similarly, the traditional output from ADMB 

has been restructured for the specific purposes of statistical population 

reconstruction. Program POPRECON can be installed without the 

installation of ADMB or a C++ compiler.   

Future versions of the program will include the expanded ability to 

incorporate auxiliary study data, and advanced model selection 

capabilities.  Further information on statistical population reconstruction 

can be found in the References section (Chapter 6).  A numerical example 

using the current software can be found in Chapter 5.   

 

 

http://www.cbr.washington.edu/analysis/apps/PopRecon


Chapter 1:  Introduction 
 

 

Page 2 
 

POPRECON 2 User’s Manual 

 

 

 

  



 

 
  

 

 

Page 3 
 

POPRECON 2 User’s Manual 

 

Chapter 2:  User 

Interface Description 

 

When Program POPRECON is started, a splash screen is displayed as shown 

in Figure 1.  The splash screen will disappear after five seconds, or the 

user can dismiss it by clicking on it. 

 

Figure 1.  The splash screen for Program PopRecon 

 

Figure 2 shows the POPRECON program dialog at startup.  The areas of the 

POPRECON dialog are as follows: 

 The Navigation Panel along the left side displays a hierarchical 

arrangement of actions.  Actions currently available are 

highlighted in blue; unavailable commands are in gray.  The user 

executes an available action by double-clicking on it.  At startup 

the only available action is “Load Harvest Data.” 
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Figure 2.  Program POPRECON Main Dialog at startup 

 

 The Model Summary along the right side summarizes the current 

state of the model development. 

 The Output at the bottom of the dialog displays all informational 

messages, along with output from AD Model Builder.    

 The main part of the POPRECON Program dialog is the center 

section where all program data and output are displayed. 

Managing Tabbed Documents 

When data is displayed, a tabbed document is created and displayed in 

the main part of the POPRECON main dialog.  Figure 3 shows an example 

with several active documents, with the one labeled “Harvest Data” 

currently being displayed.  The user can display any active document by 

simply clicking on the appropriate tab across the top. 
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Figure 3.  Main part of PopRecon dialog with several active documents 

 

 In some cases, there may be a large enough number of active documents 

so that there is not enough room to display all the tabs with the 

document names across the top.  In that case, as shown in Figure 3 above, 

the user can select the drop-down menu, displaying all active documents 

as shown in Figure 4, and select the desired document. 
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Figure 4.  Drop-down menu showing all active documents 

 

View Menu 

The View Menu at the top of the POPRECON dialog maintains a list of all 

documents that have been created during the current session.  An 

example is shown in Figure 5. 

An active document can be hidden in two ways: 

1. Click on the “X” on the currently displayed document tab to close 

it, as shown in Figure 3, or 

2. From the View menu, select the name of the document and un-

check it by clicking on its name, as shown in Figure 5. 

Note that when a window is hidden, the associated information is not 

removed from the program.  It is simply no longer displayed.  
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Figure 5.  Closing an active window “Auxiliary Harvest Data” by unchecking it in the 

“View” menu 

 

Redisplaying a Hidden Window 

In order to display a window that was previously hidden, select its name in 

the View menu and check it by selecting its name. 

Rearranging the User Interface 

All parts of the user interface—the Navigation Panel, the Output Window, 

the Model Summary, and all active documents—can be moved to a 

different part of the dialog, or outside the POPRECON dialog itself, simply 

by dragging the title bar to the desired location. 
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Chapter 3:  Model 

Setup 

 

Load Harvest Data 

As mentioned in the previous chapter, the only action available at startup 

is “Load Harvest Data” at the top of the Navigation Panel. When the user 

double-clicks on “Load Harvest Data,” he or she will be presented with a 

dialog, as shown in Figure 6, and must indicate whether or not the final 

age class is pooled.  (A description of pooled vs. non-pooled data is given 

in the Appendix A). After pressing “Continue,” the user will be asked to 

select the harvest data file. 

 

Figure 6.  Dialog asking whether the last age class of the harvest data is pooled or 

not 

The harvest data file is a comma-separated value (CSV) file.  An example is 

shown in Figure 7.  
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Figure 7.  An example of a harvest data file opened with Microsoft Excel (2013) 

Each row represents one year of harvest data; the harvest data in Figure 7 

has 5 years of data.  Each column represents one age class, with column A 

representing age class 0, column B age class 1, and so on.  The final 

column is the measure of the harvest effort for each year.  One note on 

the harvest effort:  The estimation seems to work best if the harvest effort 

is somewhere in the neighborhood of 1.0.  This can be achieved by 

multiplying the harvest effort values by a constant. 

Once the user has loaded the harvest data, a tabbed document appears 

showing the harvest data as shown in Figure 8. The Harvest Data tab 

shows the harvest data as well as the Total Catch (total number harvested 

in a year), and the Catch/Effort (Total Catch divided by Effort). 

 

 

Figure 8.  Program PopRecon after loading the harvest data 
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Model Summary 

Figure 9 shows the Model Summary panel from Figure 8 after loading the 

harvest data.  Note that three headers are in red (circled in Figure 9):  

Harvest Probability, Survival Probability, and Auxiliary Data.  The red 

highlights what components yet need to be configured in order to 

compute the parameter estimates.  The Compute action on the 

Navigation Panel will not be enabled until all components are configured 

and there is no red on the Model Summary panel. 

Note that the user must enter at least one source of auxiliary data in order 

for the parameters to be estimable. 

 

 

Figure 9.  Model Summary detail from Figure 8 
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Configure Harvest and Survival Probabilities 

To configure the harvest or survival probabilities, double-click on 

“Harvest” or “Survival” under “Configure Probabilities” in the Navigation 

Panel.  This will bring up the appropriate configuration dialog.  Figure 10 

shows the “Configure Harvest Probability” dialog.  The Configure Survival 

Probability dialog has the same layout.  The user is then required to enter 

the following before parameter estimation is allowed: 

 

 

Figure 10.  Configure Harvest Probability dialog 

 

 

 The last distinct age class.  All age classes up to the last distinct 

age class will be modeled with unique harvest/survival coefficients; 

all age classes greater than the last distinct age class will be 

modeled with the same coefficient.  For example, if the user leaves 

it at its default value of 0 (zero), then all age classes will be 

modeled with the same harvest/survival coefficient; if set to 1, age 

class 0 will be modeled with one coefficient, and all older age 

classes will be modeled with another coefficient.  Note that for 

harvest probabilities, the resulting harvest probability estimates 

are a function of both the estimated harvest coefficient and the 

harvest effort; thus, harvest probabilities for a given age class may 

differ across years due to different harvest efforts. 
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 A minimum and maximum value.  The numerical optimizer used 

to estimate the parameters needs starting values as input.  

Program POPRECON will use the mean of the range specified by the 

user as the starting value.  If random effects are enabled, the range 

will be used as a best guess as to a 95% confidence interval. 

In addition to these required entries, the user may also (1) enable random 

effects by checking the checkbox labeled “Enable Random Effects,” or (2) 

Enter auxiliary harvest or survival data by clicking on the “Auxiliary Data…” 

button. The entry of auxiliary data is discussed later in this chapter. 

Configure Aging/Reporting Data 

In some cases, not all harvested animals are aged or reported.  Animals 

that are not aged or reported are not included in the age-at-harvest 

matrix.  However, accounting for their harvest is important.  Therefore, an 

aging/reporting parameter can be included, assuming the animals that 

are aged/reported are a random sample from the total harvest.   

To enter aging/reporting data, double-click on “Aging/Reporting” under 

“Configuration” on the Navigation Panel. This will bring up the Configure 

Aging/Reporting Probability Dialog as shown in Figure 11.  

 

 

Figure 11.  Aging/Reporting Dialog 
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The user selects one of three options: 

1. Assume 100%.  This is the default.  No other action is needed if 

this is selected. 

2. Same for all years.  This is selected if the aging/reporting data is 

for all years of the study. 

3. Year-Specific.  This is selected if there is a unique aging/reporting 

data for each year of the study. 

If the user selects either “Same for all years” or “Year-Specific,” the 

“Aging/Reporting Data…” button on the dialog is enabled.  The user then 

presses the “Aging/Reporting Data…” button to bring up the form for 

entering the aging/reporting data. 

Figure 12 shows the entry from for a five-year study with year-specific 

data.  There is a data entry line for each year (unless the user selected 

“same for all years” above, in which case there would only be one row in 

the table).  In the first column, the user enters the total harvest counts for 

the year.  In the second column, the user enters the number actually 

reported and aged—those that can actually be used for the study. 

 

 

Figure 12.  Aging/Reporting Data Entry Form for year-specific data for a five-year 

study 
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Notice the “Paste from Clipboard” button at the bottom left.  If the user 

wishes, he or she can copy the data from a spreadsheet program and 

paste it directly into the table without having to manually enter it.  The 

data must conform to the table—in this case, it would have to consist of 

five rows and two columns of integer data. 

After the aging/reporting data has been entered and the user presses 

“Done,” a tabbed document appears showing the data, as shown in Figure 

13.   

 

 

Figure 13.  Aging/Reporting data displayed in a tabbed document 

 

Entering Auxiliary Data 

In order to obtain parameter estimates, at least one source of auxiliary 

data must be included.  The three main types of auxiliary data that 

Program POPRECON accepts are: 

1. Harvest data 

2. Survival data 

3. Abundance data 

All data entry forms for the auxiliary data have a “Paste from Clipboard” 

button in the lower-left corner, which functions as described above for 

aging/reporting data.   
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At least one set of auxiliary data must be entered in order to compute 

parameter estimates.  The user can enter multiple forms of auxiliary data, 

if available. 

The Model Summary panel shows what auxiliary data has been entered. In 

Figure 14, harvest auxiliary data has been entered.  In order to remove the 

auxiliary data, simply right-click on it in the Model Summary and select 

“Remove” as shown in Figure 15. 

 

 
 

Figure 14.  Model Summary with harvest auxiliary data loaded 
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Figure 15.  Removing auxiliary harvest data 
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Auxiliary Harvest and Survival Data 

Auxiliary data for both harvest estimation and survival estimation take the 

same form—the examples below demonstrate adding harvest auxiliary 

data, but adding survival auxiliary data works the same way.  The two 

possible types of harvest and survival auxiliary data are:  (1) Release-

recapture data and (2) Estimates with standard errors.  To enter harvest or 

survival auxiliary data, the user presses the “Auxiliary Data” button on the 

configuration dialog (see Figure 10).  This brings up a dialog asking the 

user to select the type of auxiliary data as shown in Figure 16. 

 

 

Figure 16.  Dialog for selecting the type of auxiliary data for harvest or survival 

parameters 
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Auxiliary Release-Recapture Data 

The dialog for entering harvest release-recapture data is shown in Figure 

17.  The data is entered at the bottom of the form (circled in Figure 17).   

 

 

Figure 17.  Data entry dialog for release-recapture auxiliary harvest data 

 

For each release-recapture record, the user must enter: 

1. The year, between 1 and the number of years. 

2. The age, between 0 and the last distinct age class (specified in the 

configuration dialog). 

3. The total number marked. 

4. The total number of marked individuals that were harvested (for 

survival data, the total number that survived). 

When the user has entered valid values in each field, the “Add” button is 

enabled.  The record is added to the table when the “Add” button is 

pressed.  
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Figure 18 shows the entry dialog with two records already added and a 

third ready to be added. 

 

 

Figure 18.  Data entry dialog for release-recapture auxiliary harvest data with data 

entered 
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Auxiliary Estimates with Standard Errors 

Figure 19 shows the entry from for auxiliary data that consists of 

estimates of the harvest probability and the corresponding standard 

errors.   

 

 

Figure 19.  Auxiliary data entry dialog for harvest estimates with standard errors 

 

Data entry works the same way as with release-recapture data described 

above, except each record consists of: 

1. The year. 

2. The age. 

3. A probability estimate between 0 and 1. 

4. The corresponding standard error. 
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Auxiliary Abundance Data 

In addition to harvest and survival data, the user can enter auxiliary 

abundance estimates and standard errors by double-clicking “Abundance” 

under “Enter Auxiliary Data” on the Navigation Panel.  Figure 20 shows the 

entry form for abundance auxiliary data.  Data is entered in the same way 

as other auxiliary data.   

 

 

Figure 20.  Auxiliary data entry form for abundance data 

 

Each record consists of: 

1. The year. 

2. An abundance estimate for the year. 

3. An estimate of the corresponding standard error. 
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Chapter 4:  Estimation 

Results 
 

 

Once the harvest and survival probabilities have been configured, and at 

least one form of auxiliary data has been entered, the “Compute” action in 

the Navigation Panel is enabled. The user double-clicks the Compute 

action to estimate the model parameters.  If successful, the actions under 

the “View Results” heading in the Navigation Panel become available with 

a few exceptions:  Harvest and survival random effects are enabled only if 

the appropriate random effects are enabled, and “Survival Probabilities” 

under “Plots” is enabled only if survival random effects are enabled (the 

survival plot would be a flat horizontal line without random effects). 

Viewing Results 

To view the Abundance Estimates, double-click on “Abundance” under the 

“View Results” header, bringing up the abundance estimates document as 

shown in Figure 21. For the abundance estimates, standard errors are only 

shown for the total annual abundance estimates in the final column by 

default.  If the user toggles the “Show all standard errors” check box in the 

lower-right corner (circled), all standard errors will be displayed. 
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Figure 21.  Abundance Estimates results 

 

All other estimates—Harvest, Survival, Recruitment, Harvest Random 

Effects, Survival Random Effects—can be viewed in the same way by 

double-clicking on the appropriate action on the Navigation Panel.  All of 

the tabbed documents for the results will have “Copy to Clipboard” 

button in the lower-left corner as shown in Figure 21, allowing the user to 

copy and paste the results into a spreadsheet or word processing 

document. 

Viewing Plots 

Annual Abundance Plot 

Double-clicking on the “Annual Abundance” action under the “Plots” 

heading will bring up a plot like the one in Figure 22. The X-axis is the 

study year, and the Y-axis is the abundance estimate.  By default, the 

black error bars show plus and minus one standard error for each point 

estimate. The buttons at the bottom of the graph allow the user to select 

“95% Confidence interval” instead, and the error bars will change to show 

plus and minus 1.96 standard errors. The “Save to File” button allows the 

user to save an image of the current plot to a PNG (portable network 

graphics) image file. 
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Figure 22.  Plot of Annual Abundance 

 

Harvest and Survival Probabilities Plot 

Double-clicking on “Harvest Probabilities” or “Survival Probabilities” 

brings up the plot of respective probabilities across years.  If the number 

of distinct age classes specified in the Harvest/Survival Probability 

configuration is zero (Figure 10), the plot will be like the one in Figure 22.  

If the last distinct age class is greater than zero, the plot will appear as 

shown in Figure 23.   
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Figure 23.  Harvest Probabilities Plot for multiple age classes 

 

Notice the selection box in the lower-right corner (circled in Figure 23).  

The default is set for “All Ages,” showing a line plot for each distinct age 

class.  The user can use the selection box to view the plot for only one 

class as shown in Figure 24.  The plot for a single age class will then 

appear, similar to Figure 22, with the user able to select which error 

interval to show for the selected age class. 

 

Figure 24.  Selecting an age class in the Harvest Probabilities plot   
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Random Effects Plot 

 

 

Figure 25.  Plot of the Harvest Random Effects 

 

Figure 25 shows the plot of the harvest random effects. This plot is 

available if harvest random effects have been enabled (similarly with 

survival random effects).  The two horizontal red lines are at 1.96 standard 

errors from zero.  If the selected model adequately fits the data, the 

random effects should have a normal distribution with a mean of 0, and 

95% of the standard errors should lie between the red lines.   
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Write Estimates to File 

Once the estimates have been computed, the user can save the estimates 

to a CSV (comma-separated-value) file by going to the “File” menu and 

selecting “Write Estimates to File….”  The user is then prompted for an 

output file name. 

 

Resetting the Estimates 

Once the parameter estimates have been computed, the user cannot 

change any of the inputs—add or remove auxiliary data, change the 

parameter configurations, etc. —without resetting the estimates.  To reset 

the estimates, go to the Edit Menu and select “Reset Estimates.”  This will 

remove all displayed results and plots, the Compute action will once again 

be enabled, and the user can then change the model setup. 
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Chapter 5:  Numerical 

Example 

 

 

Examples of data inputs and outputs using Program POPRECON. 
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Harvest and Effort Data Format 

Harvest and catch-effort data are read into POPRECON using a CSV file. 
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Auxiliary Data Formats 

Auxiliary data can be typed in the boxes or pasted from the clipboard.   
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POPRECON Output 
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Appendix A:  Pooled 

vs. Non-Pooled Data 

 

When the user loads harvest data into Program POPRECON, he or she is 

first asked if the last age class is Pooled on Not Pooled (Figure 6). Figure 

26 diagrams the age-class structure of non-pooled data.  In this case, 

there are four age classes, and an individual can only be observed in the 

final age class once before dying or exiting the study. 

Figure 27 shows the age-class structure for pooled data.  Unlike with non-

pooled data, an individual can be observed in the final age class—4 years 

old and older—for multiple years of a study.   

 

 

Figure 26.  Age-class structure of non-pooled data 
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Figure 27.  Age-class structure of pooled data 

 

To illustrate the difference, let 

 𝑝𝑖 = probability of harvest in year 𝑖, 

 𝑆𝑖 = probability of survival from year 𝑖 to year 𝑖 + 1. 

The expected value of 𝑁24 in Figure 26 for non-pooled data is calculated 

as 

𝐸(𝑁24) = 𝑁13(1 − 𝑝1)𝑆1𝑝2. 

But for the pooled data in Figure 27, both the 𝑁13 and 𝑁14 cohorts can 

contribute to the individuals in 𝑁24, thus  

𝐸(𝑁24) = 𝑁13(1 − 𝑝1)𝑆1𝑝2 +𝑁14(1 − 𝑝1)𝑆1𝑝2. 
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Appendix B:  

Abundance Variance 

Calculation 

 

AD Model Builder provides accurate estimates of the model parameters 

and functions of model parameters.  However, in the case of abundance 

estimates, it underestimates the variance.  For a given year, the 

abundance of age class is calculated as 

𝑁𝑖 =
𝑥𝑖
𝑝𝑖𝑟

 

where 

 𝑥𝑖 = harvest counts of age class 𝑖, 

 𝑝𝑖 = estimate of harvest probability of age class 𝑖, 

 r = aging/reporting probability. 

AD Model Building treats 𝑥𝑖 as a constant, whereas it is actually a 

binomially distributed random variable.  Hence, Program PopRecon 

estimates the variance as follows. 

Var(𝑁) = Var (
𝑥

𝑝𝑟
). 
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Using the Delta method,  

Var(𝑁) =
Var(𝑥)

𝑝2𝑟2
+

𝑥2

𝑝4𝑟2
Var(𝑝) +

𝑥2

𝑝2𝑟4
Var(𝑟)

+
𝑥2

𝑝3𝑟3
Cov(𝑝, 𝑟) 

 

Assuming Cov(𝑥, 𝑝) = Cov(𝑥, 𝑟) = 0, let 𝜃 = 𝑝𝑟 

 

𝐸(𝑥2) = Var(𝑥) + 𝐸(𝑥)2 = 𝑁𝜃(1 − 𝜃) + 𝑁2𝜃2 

Var(𝑁) =
𝑁𝜃(1 − 𝜃)

𝜃2
+ [𝑁𝜃(1 − 𝜃) + 𝑁2𝜃2]

∙ [
Var(𝑝)

𝜃2𝑝2
+
Var(𝑟)

𝜃2𝑟2
+
2Cov(𝑝, 𝑟)

𝜃3
] 

=
𝑁(1 − 𝜃)

𝜃
+ (𝑁(1 − 𝜃) + 𝑁2𝜃)(

Var(𝑝)

𝜃𝑝2
+
Var(𝑟)

𝜃𝑟2

+
2Cov(𝑝, 𝑟)

𝜃2
) 

 

Var(𝑝), Var(𝑟), and Cov(𝑝, 𝑟) are calculated by AD Model Builder.   
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Annual Abundance Variance Calculation 

For a given year 

 𝑥𝑖 = harvest counts for age class 𝑖, 

 𝑝𝑖 = estimate of harvest probability for age class 𝑖, 

 𝑟 = aging/reporting probability, 

 𝜃𝑖 = 𝑝𝑖𝑟. 

Var(�̂�) = Var (∑
𝑥𝑖
𝜃𝑖
) 

Var (∑
𝑥𝑖
𝜃𝑖
) = ∑Var(�̂�𝑖) + 2∑∑Cov(�̂�𝑖 , �̂�𝑗). 

 

Using the Delta method, 

Cov(�̂�𝑖 , �̂�𝑗) =
𝑁𝑖𝑁𝑗

𝜃𝑖𝜃𝑗
[𝑟2Cov(𝑝𝑖 , 𝑝𝑗) + 𝑝𝑗𝑟Cov(𝑝𝑖 , 𝑟)

+ 𝑝𝑖𝑟Cov(𝑝𝑗 , 𝑟)] 

 

Cov(𝑝𝑖, 𝑝𝑗) and Cov(𝑝𝑖, 𝑟) are calculated by AD Model Builder.   

 

 

 

 

 

 

𝑖 < 𝑗 
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Appendix C:  

Numerical 

Optimization 

 

Because closed-form estimators of parameters in population 

reconstruction do not exist, investigators must rely on computer 

algorithms to numerically solve for the maximum likelihood estimates and 

associated variance estimates.  Therefore, numerical aspects of population 

reconstruction are a very important component in the overall analysis of 

age-at-harvest data.   

 Most optimization algorithms are variations on the Newton-

Raphson method (Seber 1982:16-18).  In its original form, the Newton-

Raphson method requires the investigator to provide the first and second 

derivatives of the log-likelihood model with regard to each model 

parameter.  Most modern optimizers based on the Newton-Raphson 

method approximate both the first and second derivatives using 

numerical techniques.  AD Model Builder (http://www.admb-project.org/) 

algebraically derives the first derivatives of the log-likelihood model.  The 

analytical approach used in AD Model Builder (ADMB) is one reason it 

tends to produce reliable point and variance estimates, but the syntax of 

the software can be a barrier for some users.  In order to retain the 

reliable optimization and realistic variance estimates provided by ADMB 

and overcome the syntax barrier PopRecon was created as a user-friendly 

program with an ADMB computational core.  

 Despite the increased reliability of ADMB’s optimization routine, 

diligence is still required to assure the program finds the global maximum 

and does not produce a false convergence. To assure global convergence 

users should begin with simple models, then increase model complexity. 

More complex models will never achieve global convergence at a lower 

maximum likelihood value than a simpler nested model. Therefore a 
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complex model which does not converge to a higher maximum likelihood 

value than that achieved by a less complex nested model indicates false 

convergence. Additionally, users should begin each set of models at 

multiple starting values in order to assure the model converges to a true 

global maximum likelihood value. The model converging to multiple 

likelihood values from different starting points is another indication of 

false convergence. The highest likelihood value achieved based on a large 

number of starting values is likely to be the global maximum. PopRecon 

uses the center of the range input into the “Configure Harvest Probability” 

or “Configure Survival Probability” dialog boxes as starting values for 

parameters related to harvest probability and natural survival probability 

(Figure 10). Initial values for the variance parameters for random effects 

associated with either the survival or harvest process is based on the 

width of the range input in these boxes. If there are indications of false 

convergence users may consider collecting more data, or reducing model 

complexity.  

 When the likelihood model includes one or more vulnerability 

coefficients for modeling the catch-effort relationships, e.g., 

where  

 pi = probability of harvest in year i, 

 fi = total hunter effort, 

  c = vulnerability coefficient, 

it is often advisable to rescale hunter effort.  Numerical optimizers can 

have difficulty in locating the global maximum when parameter values are 

many orders of magnitude different.  For instance, animal abundance may 

be in the 1,000s or 10,000s while the vulnerability coefficient(s) may be in 

the range of 0.0001’s if hunter effort is large.  One way of reducing this 

range in parameter values is to re-express hunter efforts in terms of 100s 

or 1000s of hunters rather than the number of hunters.  In so doing, the 

usually small vulnerability of coefficients can be increased several orders 

of magnitude, making the disparity in parameter values less and location 

of the optimum easier and more reliable. This is why the effort numbers 

shown in the numerical example (Chapter 5) are between 1 and 3, rather 

than on the order of thousands or tens of thousands.   


